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incorporated in new editions of the publication.  The Office of Materials and 
Research (or the Georgia Department of Transportation) may make changes in the 
processes described in this document at any time. 
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typographical errors that may be contained herein.  In no event will the Georgia 
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incidental, consequential or any other loss or damage caused by errors, omissions, 
misprints, misinterpretation of the information found in this document, even if 
advised of the possibility of such damages.  The Georgia Department of 
Transportation expressly disclaims any and all liability to any person, in respect 
of anything done or omitted, and the consequences of anything done or omitted, 
by any such person in reliance on the contents of the publication. 
 

All Rights Reserved 
 
No part of this document by be reproduced, reformatted, or transmitted in any 
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of Transportation.   
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  What You Will Learn…. 
• Changes in Version 4.2 
• New FDCS Process Flow 





                Overview of FDCS 

 FDCS Training Guide 1-1 

1 Overview of FDCS 
This computer program is used by GDOT Testing Technicians and Contractor Testing 
Technicians to collect & distribute field test data. It is designed to be a standalone system 
(Client) that can be used in remote locations to collect field test data for future 
distribution to a central database (Server). 

It is composed of a collection of field test data forms that are used to collect, distribute 
and report field material test data.  This includes Roadway & Plant, Independent 
Assurance, Aggregates, and Portland Cement. 

The four major components of FDCS are 

• FDCS Client – the standalone version used in the field by technicians and plants to 
submit their test records. 

• FDCS Production Server – the central database where uploaded field test records are 
authorized by OMR supervisors. 

• FDCS Read-only Server – a non-editable view of the central database for GDOT 
personnel. 

• FDCS Webview – a secure view for producers of their own data in the central 
database. 

 

1.1 Changes in FDCS 4.2 
The following are changes since version 4.1: 

Client Side: 

• Asphalt Reports re-written 

• Aggregate Material Code Update 

• 128C Source re-assigned 

Server Side: 

• Migrated data to SQL database 

• Consolidated FDCS system to a single database (no copies) 

o Removed all batch jobs 

• Update web upload 

1.2 Functionality 
FDCS performs multiple functions: 

• Initial calculations on test data. 

• Backs up or restores data. 
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• Exchanges data between technicians. Some tests are multi-part, which are 
started by one technician and completed by another, which means two 
different computers have to talk to each other. Computer diskettes or e-mail 
attachments are the recommended media to use to exchange test data between 
technicians and at remote locations.  

• Generates hardcopy test reports and statistical summaries and quality ratings, 
including built-in calculations.  

• Allows the user to edit, review or delete test data. 

• Uploads test data to GDOT. 

• For aggregate or cement producers, imports test data from their own system to 
FDCS using templates. 

• Allows the user to import updated nuclear gauge factors to the Client after the 
gauges have been calibrated. 

 

1.3 Target Audience 
This course is designed for the following GDOT personnel who need test 
information for the Materials Certificate: 

• Construction inspection 

• Area Engineers 

• Contract Administration 

• Materials Audit 

 

1.4 Course Prerequisites 
• Basic Windows skills 

• Basic knowledge of sampling & testing requirements for construction projects 

 

1.5 Course Objectives 
In order to successfully complete this course, you will complete the following 
tasks: 

• Navigate in FDCS 

• View Data 

• Print Reports 
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1.6 New FDCS 4.2 Architecture 
The system architecture has changed since the last version of FDCS.  The main 
change has been the elimination of the batch process, which has been replaced 
with a more streamlined exchange of Client-Server data.  The new architecture 
includes the following process: 

1. FDCS Client Uploads data to the central SQL Server database. 

2. GDOT users access to the central database on SQL Server through Terminal 
Services using Production or Read-only user interfaces.  

3. External users view their own data via a secure web connection. 

 

 
FIGURE 1.  NEW FDCS SYSTEM ARCHITECTURE 
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1.7 Terminology 
The following terms are used through out this document: 

Term Description 
FDCS Abbreviation for the Field Data Collection System. 
Client The edition of FDCS on the technician’s computer. The 

data collected in this edition should be uploaded to the 
Server version and can be used to generate local reports. 

Server The central database collection of uploaded test data. The 
data can be verified and used for various reports on a 
statewide basis. 

Field When referring to data entry, a single piece of information, 
such as a measurement or a description. 

Record A group of fields that describe one entity. In this application 
the entity is usually a sample taken for testing. 

Key fields Each record must contain a field or a set of fields that 
uniquely identifies it. This prevents duplicates and enables 
searching.  These special fields are called key fields. 

Filter The process used to show you a specified selection of your 
records or just one record rather than all records at once. 

Sort The process used to put records in alphabetical or numeric 
order. Ascending is A-Z or lowest to highest; Descending is 
Z-A,  or highest to lowest. 

Form View A window containing the contents of one or more test 
records that you may view, edit, or add to.  A printed test 
record is often called a “report.” 

Datasheet 
View 

A table format displaying the same records shown in Form 
View. 

Web View The secure internet link for Producers to view their own 
uploaded records in the central database. 

Report A record or group of records, or calculation obtained from 
one or more records, specially formatted for printing. 

Upload The process of electronically sending data to the GDOT  
central database via the Internet. 

Import The process of adding data to the system from a source other 
than your default directory. 

Backup The process used to save data to another location the event 
of a system failure. 

Restore The process of adding backed up data to your default system.  
This is done if the data on your default system was corrupted 
or lost. 
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  What You Will Learn…. 
• How to Install FDCS Server 

icon 
• FDCS Server Navigation 
• How to Generate, Print, and 

Save Reports 
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2 FDCS Server View 
FDCS Server is the central database for test data collected on GDOT projects or at 
producer’s Quality Control labs and Uploaded from the FDCS Client. The Terminal 
Services function allows GDOT personnel to quickly view central database information 
through “FDCS Server Read-only”.  For most GDOT personnel this is the link to use for 
test record review. Please note that the data cannot be changed when using this link.  

  
OMR Testing Management supervisors (TMOS) and Technical Services Engineers (TSE) 
have special permissions to update and verify (authorize) FDCS test records Uploaded to 
the central database. Contact the Branch Chief or Supervisor to get “FDCS Server 
Production” permission established and the link installed on their computer. Users who 
do not have the necessary permission will receive an error message. 

2.1 Installing the FDCS Server link 
 

To install terminal services, do the following: 

1. On the Desktop, double click on My Computer 

2. Go to 
\\gdot.ad.local\gdot\Construction\Materials_Research\Systems\Install\Field
Data 

3. Select the FDCS Server Read-Only icon. This is an .rdp file. 

4. Drag and drop this link to your Desktop for future use. 

5. Exit My Computer. 

 

To open FDCS Server Read-only: 

1. Double click on the FDCS Server Read-Only icon on the Desktop. 

2. Click Ok.  The Logon window opens. 

3. Enter your GDOT network User name and Password,  

4. Click Ok.  The Read Only Field Data Database opens.   
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On the Main Menu, users have the ability to filter records for a single District only, 
rather than viewing all records statewide. The four tabs available are: 

• Unverified Data – a filtered view uploaded data for test records that have not 
been Verified (authorized) by OMR personnel. 

• Browse Data – all data that has been uploaded to the central database. 

• Reports – Asphalt, Aggregate, Cement, and other Materials Summary reports for 
all producer and technician submitted test records. 

• Gauge – View, Edit, and Print functions for Nuclear Gauge calibration functions. 
‘Create Nuclear Gauge File’ and ‘Update Gauge Factors from Update Disk’ are 
active in FDCS Server Production and are not available in FDCS Server Read-
only. (This topic is covered in the FDCS Admin class.) 

2-2    FDCS Training Guide            
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2.2 Viewing Unverified Data 
The Unverified Data tab on the Main Menu includes links to each of the forms in 
FDCS. When the user clicks on a button, the form view opens with the only the test 
records that have not been Verified (authorized) by a TMOS or TSE. This is a tool to 
bring the newly submitted test records to their attention, rather than searching through 
all records to find those that need authorization. 

To open an Unverified test record: 

1. On the FDCS Server Main Menu, click the Unverified Data tab. 

2. Click the DOT 159 button.  The DOT 159 form window opens. This is the same 
form that is seen on the FDCS Client. 

3. Click the Next Record button at the bottom of the form. Notice that the number 
of records has been filtered; this indicates the number of records waiting to be 
authorized. 

4. Close the DOT 159 window to return to the Main Menu.   

 

2.2.1 Form features 
This is an example of a generic form. 

 

 

 
 

 

Note:  If the field on the form has a border, you can add data.  If the field does 
not have a border, it is considered a calculated field and is generated by the 
FDCS system based on your input in either fields on previous windows or 
other fields on the form. 

2 

3 

4 

6 

7 8 

9 

10 12 

11 

5 1 

13 14 

 Feature Description 
1 Selection Bar Clicking this selects records for copying or pasting. 
2 Title Bar You can drag this to move the window. 
3 Minimize Click here to make the form smaller. 
4 Maximize Click here to make the form bigger. 
5 Close & 

Save Data 
Click here to close the form and automatically save the 
data you entered. 
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6 Scroll Bars If the form is too big to fit in the window you can use the 
scroll bar. 

7 Resize  If the window is too small you can drag this to make it 
larger. 

8 Total  Displays the total number of records.  
9 New  Creates or moves to a new record.  
10 Last  Takes you to the last record for the form selected. 
11 Next  Takes you to the record after the one displayed on the 

form. 
12 Display Area Shows the record number you are currently viewing. 
13 Previous  Takes you to the record before the one displayed on the 

form. 
14 First  Takes you to the first record of the form selected. 
 

2.3 Browsing Data 
The Browse Data tab on the Main Menu includes links to each of the forms in FDCS. 
Users have two options – Open and Find.  

When the user clicks on the Open button, the form view opens with all those test 
records in the central database. This includes all Unverified records.  

When the user clicks on the Find button, a window with selection parameters gives 
the opportunity to filter the records to only those that meet the criteria. Notice in the 
upper zone ‘Find by key information’ that more than one criteria can be entered. For 
instance, if Plant Number “123” and Type Mix “12.5mm” are both entered then only 
the records that match both criteria will be shown in the form view. 

2-4    FDCS Training Guide            
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2.3.1 Find / Filter / Sort records 
To find a recent test record for a contract/project: 

1. On the FDCS Server Main Menu, click the Browse Data tab. 

2. Click the DOT 159 Find button.  The Find DOT 159 window opens.  

 
3. In the Contract ID field, type “T00000-00-000-0.” 

4. Click the Find button under the Contract ID field. 

5. The DOT 159 form window opens. This is the same form that is seen on the 
FDCS Client. 

 
6. Click the Last Record button at the bottom of the form. Notice that the 

number of records is filtered; this indicates the number of records for the 
criteria selected. 

    FDCS Training Guide           2-5 



FDCS Training Guide 

7. On the Menu bar, click View\Datasheet View. The window switches from a 
form view to a table view of the test records. 

 
8. Scroll to the right, and click in the Date field. 

9. On the Menu bar, click Sort\Sort Descending. This will sort the records to 
show the most recent test records at the top of the table. 

10. Click in the Type Mix field. 

11. On the Menu bar, click Filter\Filter by Selection. Notice that this limits the 
records shown to just those for the type of asphalt selected in step 10. 

12. On the Menu bar, click View\Form View. The window switches from a table 
view to the familiar form view of the test records, including the Print button. 

Note: Find, Filter, and Sort can be used for any field selected in the test records. 
Filter and Sort can be done when in Form view as well as in Datasheet view. 
Datasheet view simply shows multiple records at the same time.  
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2.4  Reports 
There are multiple reports available for FDCS Server.  Click the Reports tab to view 
these report options. 

• Asphalt Plant Rating Reports include the following: 

Report Name Report Description 
Asphalt Plant Rating The asphalt plant rating system was 

developed using the Mixture Control 
Tolerances established in Section 828 of 
Georgia’s Standard Specifications. Uses 
the data from all of the entered 159 
Asphalt Concrete Lot Worksheets within 
the specified time range to generate a 
rating for a specified plant. Requires three 
samples per product code to be rated. 

Asphalt Plant Rating Probation Same as above, but there is no minimum 
number of samples needed to generate a 
score.  

Asphalt Tonnage Report A report of all tonnage from all 159s 
within the specified time range. 

IPD and PCT Voids Report A statistical report of in-place densities 
and percent voids for each asphaltic 
concrete mix. 

Gradation Report A statistical breakdown of gradations for 
each asphaltic concrete mix. 

Lots Summary Report A summary report of Asphalt Lots per 
Contract ID 

# of Reports per Asphalt Plant Count of DOT 159 records per plant for 
the date range entered. 

# of Reports per Plant by District Count of DOT 159 records per plant for 
the date range entered, sorted by District 
number. 

Statewide Average JMF Deviations Averages, Standard Deviation, and 
number of Sample per sieve sizes, sorted 
by Type Mix. 

List of all projects entered by users Produces a list of unique project codes 
gathered from all entered 159 reports. This 
helps identify incorrectly typed project 
codes. 

• Aggregate Reports include Quarry Rating reports and Aggregate test record 
Summary reports. 

• Portland Cement Reports include selection criteria for Mill Code, From/To date 
ranges, or Material Type. All criteria are optional for limiting the records shown 
on the report. It is recommended that at least one criteria be entered, and multiple 
criteria can be used when generating a report. 
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• Materials Summary Reports include selection criteria for Material Test Type (by 
form number), From/To date ranges, Contract ID, or Technician ID. The Material 
Test Type is required, but the other criteria are optional for limiting the records 
shown on the report. Notice that multiple criteria can be used when generating a 
report. 

2.4.1 Generating a Lot Summary Report: 
To generate a test record report for a contract/project: 

1. On the FDCS Server Main Menu, click the Reports tab. 

2. Click the Asphalt Plant Ratings button. 

3. Click the Lots Summary Report button. The DOT 159 Lot Summary 
Report window opens. 

 

4. In the Contract ID field, enter T00000-00-000-0. 

5. Click Get Details.   

Note:  You might receive an error that states, No Record Found. Error 1. Just 
click OK. 

2-8    FDCS Training Guide            
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6. The Lots Summary report opens. 

Note: Each Type Mix is grouped and a Total Quantity for each mix is 
calculated. The Lots are listed in numeric order, making it easier to notice 
missing Lots or missing compaction data.  
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2.4.2 Generating a Materials Summary Report 
To generate a summary report for other materials: 

1. On the FDCS Server Main Menu, click the Reports tab. 

2. Click the Materials Summary Reports button. The summary reports 
selection window opens. 

 
3. The Material Test Type is a required field. Select DOT 150 from the 

dropdown list. 

4. In the Contract ID field, enter T00000-00-000-0. 

 
5. Click OK. The Materials Summary Report opens. 
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Note: You can only Print this report.  The Email File feature is currently 
unavailable from the Terminal Services connection. 

2.4.3 Printing Reports from FDCS Server 
This is a continuation of the previous exercise and assumes you have opened a 
form for a test record. 

1. On the DOT 159 form, click the Print in English Units button. The report 
window opens. 

 
2. On the menu bar, select File>Print. 

3. When the print dialog box appears click OK.  
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2.4.4 Saving Reports from FDCS Server 
Terminal Services acts a remote desktop to help speed the access to the data in 
FDCS Server. This also means the user in not on their own Profile on the 
computer with all the connections to their e-mail account. Therefore, in order to 
share the results of a report with people who do not have access to FDCS Server, 
the report must first be saved. 

To save a report to a folder: 

1. In an open report, from the File menu, select Output to Document. 

 
2. Select the network folder where you wish to save the report, then click OK. 

Note: It is recommended that you Save in: a mapped network drive such as a 
personal share or an office directory (like Q: or R: for OMR personnel). 

Note: Be sure to use the rtf extension on the file. The Rich Text Format (.rtf) 
preserves the special formatting and header information in the test report. If you 
try to save the report using any other format extension it rearranges the data 
within the test report. 

3. Click Close.  You are returned to the DOT 159 window. 

4. Close the window to return to the FDCS Server Main Menu. 
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2.4.5 E-mailing Reports from FDCS Server 
Do NOT use the EMAIL button or File\Send to Recipient to send FDCS Server 
reports to others. See 2.4.4 for more information on saving reports so they can be 
shared with people who do not have access to FDCS Server. 

To email reports saved from FDCS Server it is recommended that you save all the 
reports to one folder on your computer. Then create an e-mail message and insert 
the reports into the message. 

To e-mail FDCS reports as attachments: 

1. Open your email program.  

2. Create a new message.  

3. Use the Insert menu to select and include saved FDCS report files in your 
email message. 

4. Address and Send the message. 
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